WKO+ 3.0 User Guide

Installing WKO+ 3.0
1.

Make sure you are logged into Windows with a user profile that has Administrative privileges.

2.

Go to our WKO+ Download page by CLICKING HERE.

3.

From there, download the latest build of Version 3.0 (select Save, not Run, if you have an
option).

Make sure that no other software that talks to your downloadable training devices is open or running,
including your current version of WKO+, CyclingPeaks, or Ergoracer.
The following screenshots outline the download and installation steps:
1. Download the WKO+ installation file.

2. Save the installation file to your computer by clicking 'Save File'

3. You may be prompted to choose a location, so save it to a place you can find easily

4. Download the saved .exe file. When it has finished downloading, browse for the file location.

5. Double click the setup file to Run it. You may recieve a security warning. If so, agree to allow the software
to install

6. The InstallShield Wizard will launch and begin the software installation

7. Select shortcuts to desktop and start menu, if desired

8. Click 'Finish' to complete the installation

9. Your software should now be properly installed. You can verify your version and build by opening the
software, going to the Help menu and scrolling to 'About TrainingPeaks WKO+v3.0' as shown below

The version and build will be listed in a pop up box as shown below

To activate your WKO+ license, please follow these steps:
1.

Make sure that you have installed the very latest version and build number of WKO+. Follow
these steps for how to update to the latest version and build number of WKO+.

2.

Once you have downloaded and installed the latest version and build number, open WKO+.

3.

Make sure your computer is connected to the internet.

4.

Then, in the Registration Form of WKO+ (which should appear automatically if your license
has not yet been activated, but if need be can also be accessed from the Help menu by
clicking Register), follow these steps:
○
○

○
○

Enter your full Name
Enter the Registration Code (CaSe SenSitiVe and dashes () matter) which you
received during the purchase process and with the email confirmation of your
purchase, or within the CD sleeve if you purchased from a retail distributor
The Fingerprint field should be autopopulated with the hardware fingerprint ID of
your computer
Next, click the Activate button in the lower right hand corner of the Registration
Form, and your copy of WKO+ will activate

Migrating Data from Older Version
If you are a current registered user of TrainingPeaks WKO+ you can follow the steps below to import your
WKO+ files to WKO+ 3.0:
There are three ways to migrate your data from 2.2 to 3.0. We recommend the first way. If you are a more
advanced user or would like your files renamed in our new file naming:
last_first_yyyy_mm_dd_hh_mm_ss.wko then do the 2nd way. If you are a seriously advanced user, then
choose #3.
#1 After you have installed Version 3.0, then make sure it is closed, along with Version 2.0. This way will
bring in all of your data files, Custom charts and graphs and also any athletes you might coach as well.
1.
2.

Click START>PROGRAM FILES> TRAININGPEAKS>
Then Click MIGRATE Data from 2.2 to 3.0.

3. When you are ready then click any key on your keyboard.

4. Wait for the migration to happen and let it run.
DONE!
OR Choose Option # 2
DRAG and DROP method. This will bring in your files one athlete at a time. In order for this to work, you
will need to "CREATE AN ATHLETE" first and then drag and drop the data. NOTE: this method will not
bring over any custom charts and graphs you might have built on your Athlete Home page or Journal page.
1.
2.
3.
4.

Browse to your old files using Windows Explorer
Once you have found the files, with Windows Explorer open in a smaller window, click
"Edit...select all". This will highlight all of your files.
Open WKO+ 3.0 and run the application small on your monitor (you should see both programs
on yoru monitor screen now).
Left click on the highlighted data and DragandDrop it directly ONTO WKO+ 3.0

5.
6.

The next screen you will see allows you to select the correct Athlete, Sport, and the correct
workout date. Select the athlete you want to import data into, the correct sport, and update
workout dates if any were incorrect.

7.

8.
9.

DONE! Or repeat for each athlete.

OPTION #3  Copy the DATA folder yourself from Within the Program Files directory. This is really a
continuation of Option #2 above.
1. Goto your My Documents folder and look for the folder named CyclingPeaks. It could also reside in
C:Program Files/TrainingPeaks/WKO/CyclingPeaks/Data
2. Find the DATA folder.
3. Copy the Data folder.
4. NOW open My Documents /TrainingPeaks/WKO and PASTE in the Data folder on top of the existing
one.
5. This will overwrite the existing folder with your 2.2.
6. Open up WKO+ 3.0 and give it a few minutes to compile the data. It should all be there.
Note: if your FTP settings for your athlete did not come over or your charts are not in there. then you can
copy over the athlete.dat file or calendar.dat over top from your 2.2 to your 3.0. Allow them to overwrite in
the Document/user name/TrainingPeaks/WKO
===========================================
Also you could follow this path, which will do the same thing as well.
1. Create a new athelete in WKO+ 3.0
2. Optionally, close WKO+ 3.0 and copy just your
athlete_last_first.dat file from the 2.2 data folder to the 3.0 data
folder, then restart WKO+ 3.0. This will bring over your athlete
settings, charts, FTP history, etc.
3. Dragndrop all your 2.2 .wko files on to the main WKO+ 3.0 window.
4. When the import files dialog finishes reading all the files, choose
your athlete and hit save.

One warning though, manually overridden TSS values were not beeing
saved in the 2.2 .wko file, so you will loose those. They are now
begin saved in the 3.0 .wko files, so going forward this is not a
problem. If you do not know what I am talking about, then it is not an
issue for you.

Importing Training Device Data to WKO+
v3.0
Direct Downloading from a Training Device
1.

Install the software that came with your device, as this is what contains the drivers (small
packets of software that allow your computer to "talk" to your device). Do not run the
manufacturers software when trying to download from your Device to WKO+, but it does
need to be installed on the same computer as WKO+
2. Close all other training related software
3. Open WKO+
4. Open the File menu and click "Training Device Download", or click the device download
icon in the top toolbar, which will launch Device Agent v3.0
5. Once the Device Agent is open, connect the download cable or wireless dongle for your
device to your computer
6. Select the correct Training Device Type and Training Device Port (the correct port will have
text mentioning "USB", "Serial", or both, in parenthesis off to the right of the com number;
or it will default to the correct one that can not be changed) at the top of the Device Agent
7. Connect your device and turn it on
8. Click "Download from Device" in the upper right hand corner
9. Once the files have been extracted from the device, they will be listed by date in the
Download Window. Select WKO+ for the location you wish to send the downloaded files to
by clicking on the icon within the Save To column, then select WKO+. Once you have
selected the desired Save To destination, click the Save button in the lower right hand
corner of the Device Agent
10. Select the athlete profile in WKO+ you wish to save the files to in the following WKO+
Import Window

Importing Existing Data
To import your data in WKO+, you will need to use Windows Explorer to locate your stored data. You will
then highlight, copy and drop that data into the open WKO+ program. Simple enough if you have used those
‘internal’ Windows tools, but for those of you needing specific directions, here they are.
1) Find your data! This will be different for each training device and computer environment (ie, different
versions of windows).
2) To Open Windows Explorer: Start Programs Accessories Windows Explorer or right click on the Start
icon located in the lower left hand corner and click Explore.
3) Locate My Computer then click on the [+] symbol beside your Local Drive C: (your hard drive). From here,
it varies by device type.
4) You will want to take all of that data and highlight it. Go to Edit at the top of the screen and click on
“Select All”. This will make all your data “turn blue” or become highlighted. Note: if there are other files within
this folder besides your .csv (or .srm, .hrm, .txt) files, remove them. Do not import other files that do not
contain training data (for example, do not try to import a .exe file). This will only slow down CyclingPeaks
software or may cause a malfunction. Left click on the blue highlighted data, drag the data on to the open
WKO+ program and drop (let go of the left click).
5) Please open Device Agent. You can download the latest version of Device Agent
here:http://support.trainingpeaks.com/deviceagent.aspx
6) Click File > Options and make sure the Save To location is set to WKO.
7) You will now need to drag the files from step 4 into Device Agent. To do this, you just LEFT CLICK on the
highlighted files and then DRAG your MOUSE over the open Device Agent application. Then RELEASE the

left mouse button. This will DROP the files into Device.
8) Click Save in the lower right corner of Device Agent to send the files to WKO. You will now need to import
this data into the correct WKO+ Athlete. Use the scroll down arrow to locate your newly created athlete.
Click on the Save button.
9) Choose the correct sport.
10) Your data will start copying into your file and calendar and will be converted into the .wko file format (the
file format of WKO+). THAT’S IT!!!!! You are now ready to start looking at your data.
●

Here is an screenshot example showing how to do this; although the picture is showing PWX
files, the import procedure behaves the same regardless of device type (the only difference
being that the files will be located in different folders):

Combining Workouts
Sometimes, for a variety of reasons, files are downloaded in to WKO+ that a user would like to combine into
one continuous file. Below are the steps to follow to combine a workout file into one workout file:
1.

Open the workout file in WKO+

2.

Go to the "Graph" view for that workout in WKO+

3.

Highlight in the Graph the section you want to combine to the other workout. To highlight the
section, place your cursor on the graph and left click (hold down left click) and drag the cursor
across graph to where you want it and release.

4.

Open the edit menu and click "Cut."

5.

Double click on the Athlete name, then click on the Calendar tab.

6.

Double click on the workout you would like to combine the other workout to.

7.

Go to the "Graph" view of the workout, open the Edit menu and click "Paste".

By following these above steps you will cut and paste one section of a workout to another workout, thereby
splitting the combining. Save the combined file and you are all set.

How to Split a Single Workout File in to
Multiple Workout Files
Sometimes, for a variety of reasons, files are downloaded in to WKO+ that contain more than one workout,
but the user would prefer that each workout were contained within individual files. Below are the steps to
follow to split a workout file into multiple workout files:
1.

Open the file in WKO+

2.

Go to the "Graph" view for that workout in WKO+

3.

Highlight in the Graph the section you want to cut out. To highlight the section, place your
cursor on the graph and left click (hold down left click) and drag the cursor across graph to
where you want it. Release left click.

4.

Open the edit menu and click "Cut"

5.

Click on "TrainingPeaks WKO+ Home" in the Navigation box, then go to the file menu and
click "New Workout"

6.

Go to the "Graph" view of the new workout, open the Edit menu and click "Paste".

By following these above steps you will cut and paste one section of the combined file into a new workout,
thereby splitting the file. Save both files and you are all set.

The TOOLBAR consists of the links that run horizontally across the top of your screen. They are active or
inactive (grayed out) depending on the view you are in. For example the 'scissors'(cut) and 'two pieces of
paper'(copy), only become active when you have selected an area of data in the Graph View.
The TOOLBAR gives you short cuts to many of the features under the "File, edit, view, etc." menu at the
very top.

The Navigation Explorer is the area on the left side of your screen that contains the following sections:
ATHLETES

OPEN FILES
MULTI FILE ANALYSIS
SETTINGS

Toolbar

1.

2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

12.
13.
14.
15.

NEW WORKOUT: create a new workout for the selected athlete. You can also create a new
workout by rightclicking on the date (while viewing the athlete's calendar) and selecting
"create a new workout".
OPEN: this will bring up an explorer window for you to select the file you want to open
SAVE: use this button to save a workout you have created or modified.
CUT: used to cut text in a workout
COPY: copy text from a workout
PASTE: paste text from a workout
PRINT: Print a chart, or graph.
DOWNLOAD: download data from your training device. This will open the Device Agent .
CONFIGURE DEVICE: This is for users of power meters that have configurable computer
heads. Currently, we support only the
ergomo pro.
POWER PROFILE: The Power Profile is a way of comparing your data to others in an easy to
understand chart. The Power Profile is made to help you distinguish between your strengths
and weaknesses and also help you to learn which area of cycling you might want to train first.
HELP: access the online help documentation for TrainingPeaks WKO+
CREATE NEW PERSPECTIVE: use this to create a new set of charts and settings for
different types of workouts.
PERSPECTIVE LIST: Click the dropdown box to access the different perspectives you
created.
DELETE PERSPECTIVE: Delete a perspective here.

Perspectives allows you to view chart setups
for MultiSports
Perspectives was introduced in version 2.2 and is a handy tool for all the multisport athletes out there along
with anyone that just wants to have quick access to a whole other set of charts.
In the Athlete Home page, all you have to do is click the Down Arrow in the perspective box in order to
choose a different perspective.

For the Triathletes out there, this is a simple and easy way to see just the charts that apply that sport.
Let's look at the Runner perspective, which allows you to view your pace based workouts very easily, as all
the default pace based charts are there for you to see by just clicking on the dropdown menu. You can add
charts, remove charts, etc inside each perspective and even under ATHLETE SETTINGS menu in the
JOURNAL page) you can make a perspective your default so each time you open the program it's there for
you.

Other perspectives are just as easy to use and customize, so play around in here to get a better
understanding of your data.

Athlete Area
The Athlete Area is where you will see your list of athletes. From here you can manage your athlete data,
load an athlete's workout information, create groups to organize your athlete list, and create/delete athletes.
Athlete Toolbar:

1.
2.
3.

4.
5.
6.

Create Athlete: use this button to add a new athlete to your WKO+ software.
View: use this button to view the information for an athlete. Highlight the athlete's name who
you want to load, and then either doubleclick that name OR click this "View" button to open
the athlete.
Delete Athlete: this will delete the athlete that you have highlighted.

7.

Manage Groups: use this feature to create groups and then add athletes to the groups. To
add a new category, simply type the category name in the field over top of the current one.
This will add a category without deleting the others. When you are ready to group athletes in
categories, just highlight the name on the left and click the right arrow to add that person to
the category.

5. Search Box: type a name in this empty field and the search results will appear in your athlete list. If you
only want to search within a specific group, make sure that group is showing in your athlete list (see #6
below).
6.DropDown Box: use this dropdown box to choose which group you want to display in your athlete list, or
select "display/search all groups" to list everyone.
7. Athlete list: this is where your athletes will be listed.

Open Files
The "Open Files" are is where you will find a list of the workout files that you currently have open. Initially,
you will just see the three Tabs across the top(Athlete home, Calendar, Chalkboard) To open a workout,
click on the Calendar page and then doubleclick on a workout.

Once a workout is open you can move between the tabs and also create ranges, zoom in on data, etc. If
you see a '*' to the left of a workout date, this indicates unsaved changes have been made to that workout.
Be sure to save that workout. To access more information about a workout, see the four tabs across the
top of the workout area (Journal/Graph/Quadrant Analysis/Scatter Graph). To close a workout, click on the
'X' in the upperright corner, next to the 'Options' link.

MultiFile/Range Analysis(MFRA)
MultiFile/Range Analysis(MFRA) is a new feature in Version 3.0 that allows you to overlay workouts or
ranges of a workout on top of each other. Want to compare all 10 of those hill intervals to each other and
look at them graphically? This is the place to do it. Want to compare one entire ride to another and see
how the data compares visually to another? This is the place. MultiFile/Range analysis works best when
you select an exact range of data and compare it to another exact range.
You can create a MFRA in two ways.
1'Linking' ranges of data together from within the graph view.
2Sending a workout to a MFRA and then opening another workout and "adding" that workout to the first
one.
Let's teach you how to do each!
#1 Linking ranges of data together from within the graph view.
A. First, you need to create a range(s) inside a workout on the Graph page. Once you have created the
ranges of data that you want to further examine, then you need to 'Link' them together.

Features inside MultiFile/Range Analysis
Once you have created a MFRA, then you can do a few things with it.
1View the Graph, Quadrant Analysis(QA) or Scatter Graph(SG) for the ranges.
Click on the tabs at the top of the MFRA, to view the QA and SG for those ranges.
2HIDE or SHOW range.

Right click on the range in the RANGES bar in order to HIDE or SHOW the Range in the Graph, QA or SG.
3Bring a range to the 'front'.
To bring a range to the 'front', just left click on that range and the range colors will come to the front, allowing
you to see them more easily.
4Sort range(s).
To sort any range by the column, just click on the Title bar at the top of the range that you want sorted.

5Create Gridlines and adjust scaling on YAxis. CLICK HERE to read how to create a grid line.

To create gridlines or adjust the scaling on the YAxis, you do this just like you would in the normal graph
View. Click here to read about how to do this.

6 Copy Raw Data from Ranges Grid. To extract the metrics out of the ranges grid at the bottom of an
MFRA you have created, then click in the MULTIFILE menu at the top of the program and select COPY
RAW. This is copy the data in your clipboard. Now open up your favorite program(excel, etc) and PASTE
into the program.
B. After you have linked the ranges together then, right click on one of the linked ranges and choose To
Create a multifile/range.

C. Name the MFRA and then click Ok.
D. The MFRA will show up on the LEFT NAVIGATION Window. Double Click on the TITLE of it to view it.
E. Now you can view the ranges overlaid on each other, along with the metrics for each.

#2 Sending a workout to a MFRA and then opening another workout and "adding" that workout to the first
one.
A Open a workout and right click on the ENTIRE WORKOUT and then choose "Create a MFRA".

BOpen the MFRA by doubling clicking on the Title of the MFRA you just created in order to become
selected and able to have another one inserted into it.
COpen the second workout and then RIGHT Click on the 'Entire Workout'.
DChoose "Add to MFRA: Name of MFRA you are adding to".

E Double click on the Title of the MFRA to view it.

Settings
The Settings area allows you to manage your application settings, which include your TrainingPeaks.com
information, the way athlete names are shown, and the Color Settings.

1.
2.
3.
4.
5.
6.
7.
8.
9.

Click this button to expand all the settings. You can also expand just one group by clicking
on the '+' symbol to the left of the setting header.
This will sort the color settings alphabetically
Open a saved Color Scheme
Save a Color Scheme
Revert back to default settings

Changing Color Settings:
You can customize the color settings for your account. To change a color setting, just click on the color
box and that will popup your color options. Once you have your color settings how you want them, be sure
to click the save button (#4 above).
TrainingPeaks.com Settings:
This area allows you to enter your TrainingPeaks.com user name and password if you will be using
TrainingPeaks.com with WKO+. You can also enable or disable this feature through the settings area.
To watch a quick video on Batch Download from a Personal Edition TrainingPeaks account, CLICK HERE
To watch a quick video on Batch Download from a Premium Edition TrainingPeaks account, CLICK HERE

Athlete Data
This "Athlete Data" section goes into details on how to review data and training for an individual athlete. To
load an athlete's data, either doubleclick on the athlete's name or highlight the name and then select "View"
from the "Athlete" section tool bar.
For information on how to migrate your data from version 2.2 to WKO+ version 3.0, CLICK HERE.
Once you have an athlete open for viewing, you will see the main data area has three tabs:
ATHLETE HOME
CALENDAR
CHALKBOARD
You can have multiple athletes open at one time, allowing you to quickly move from one athlete to another.
If you want to close an athlete, click on the "X" in the upper rightarea of your screen, to the right of the
"Options" link.

Athlete Home
This page displays a summary of the athlete's data and downloaded data, displayed in charts/graphs. This
page allows you to view your data over longer time periods. You will be able to see the trends of your
fitness here, along with being able to configure your zones and analyze specific data. Charts can be added
to this page through the "Options" link in the upperright corner. Below is a list of the types of charts
available.
Settings and Charts on the Athlete Home Page:
ATHLETE SETTINGS
CREATE ADDITIONAL ATHLETES
POWER, HEART RATE AND PACE TRAINING ZONES
SUMMARY
DISTRIBUTION CHARTS
MEAN MAXIMAL POWER CURVE CHART
PERIODIC CHARTS
PERFORMANCE MANAGEMENT CHARTS

Athlete Settings

Click on any of the setting boxes to either manually type in information or to access the dropdown selection
box for that setting.
Back to Top
Create Additional Athletes
To create a New Athlete:

1.
2.

Click on File and select "Create New Athlete"
Type all the personal information. If you do not know the fitness data yet, give it a guess. You
will be able to edit this information easily later as you get your Fitness information. All fields
must be entered.

3.

4.

Power, Heart Rate and Pace Training Zones

There are multiple options for calculating your zones:
1.
2.
3.

4.

Click on the "Options" link to access the dropdown selection box. Click on "Calculate Zones"
to use one of the methods available to set your zones.
You can also manually set your power and heart rate zones by editing the "From" number.
Create your own custom Zone methodology by clicking "New Zones". From here you type in
the name of your zones, and then create the corresponding ranges. Using this options will
allow you to calculate zones based on your personal training philosophy.
You can also change your zones by editing your Threshold Power, Watts, HR and then
"Recalculating" your zones using one of the available calculation methods.

***Note: You can assign zones to a specific time period. In order to do this, you must first click
OPTIONS>NEW ZONES for each new date range. Then you must type in the date field the new date that
you want the data associated with. Change the value in the Threshold power window and then hit the key.
Also click OPTIONS> CALCULATE ZONES to get the numbers in the window to recalculate with the new
zone value.
If you just change the date in the window and do NOT click Options> NEW ZONES, then you will
overwrite the previous data with the new zone value. So, it's VERY IMPORTANT that you always
click OPTIONS> NEW ZONES when you are creating a new zone.
Changing your zones and the value it is associated with is an important task. This allows you to change
your zones as your fitness changes! It's a good idea to change your zones through out the year. By
assigning zones to time periods you will affect only that data that falls in the time period you establish. In
this manner, you TSS and IF will be valid for each time period, and not skewing your data as your zones
change. ***

Summary
You have the ability to Copy your information out of the Summary window and paste it into a spreadsheet or
word processing program. To do this, click "Options...Copy".

Distribution Charts

The chart above is an example of a Distribution chart. This one measures Power Distribution through out
the last 28 days of riding.
Charts can be customized and added to your Athlete Home Page.
Options for this Distribution Charts include:
COPYyou can copy either the chart picture or the RAW DATA and paste them into an email or another
document.
CUSTOMIZE  click this option to customize the distribution chart
ZOOM  this changes the size of the chart so that it displays near full screen. To return to the normal view,
click on the X next to options in the upperright corner.
PRINT  will print the actual chart
CLONE  create a new chart with the same settings
MOVE  move the chart to a different perspective

Mean Maximal Power Curve Chart

The above is an example of a Mean Maximal Power Curve Chart. This one is a representation of your
"Peak" or best power over all time periods that you rode in the last 28 days. This was developed using a
logarithmic scale in order to emphasis your fitness changes in shorter time periods. Want to know what
your peak effort for 1 minute 30 seconds in the last 28 days? Here is where you can find it!!
There are two lines on the chart, and each one represents a different time frame. You can set those time
frames (one defaults to 28 days) by clicking Options...Customize Chart.
Hover your cursor over the line and it will show your peak or best power at different times throughout the last
28 days.

Options for a Mean Maximal Power Curve Chart include:

COPYyou can copy either the chart picture or the RAW DATA and paste them into an email or another
document.
CUSTOMIZE  click this option to customize the chart
ZOOM  this changes the size of the chart so that it displays near full screen. To return to the normal view,
click on the X next to options in the upperright corner.
PRINT  will print the actual chart
CLONE  create a new chart with the same settings
MOVE  move the chart to a different perspective

Periodic Charts
Periodic Charts come in all shapes and sizes. The most popular one will be your Mean Maximal Power
Chart. One important thing for you to do with these charts is to change the date range on them, so that you
can follow your fitness throughout a longer term period than just the defaulted last 28 days. Read below on
how to do this along with a few other important tips.

The chart above is an example of a Periodic chart available in WKO+.
This specific chart measures Training Stress and Intensity Factor for the last 28 days. Developed by
Andrew Coggan, PhD and TrainingPeaks Software, Training Stress Score (TSS) and Intensity Factor (IF)
give quantitative measurements of the stress that each ride caused to your body and also the intensity of
each ride. These are great guides to help you better determine the quality of your workout and also exactly
how hard it was! A TSS score of 100 with an IF of 1.0 correlates with one hour of effort at your lactate
threshold, or a one hour Time Trial.
Periodic Charts can measure other data over a specific period of time. These settings are accessed through
the "options" button.
Options for this Chart include:

COPYyou can copy either the chart picture or the RAW DATA and paste them into an email or another
document.
CUSTOMIZE  click this option to customize the chart.
This is one of the most powerful features in the charts. It allows you to customize, make and build charts
however you want to. You can change the size, the date range, the content being charted, how much data
is charted on each point and how the chart looks as well. The possibilities are endless. We only offer a few
options here to help you get started with this great feature.
Click OPTIONS>CUSTOMIZE THIS CHART>DETAILS TAB and then ADD. This will allow you to ADD in a
series of data. IN the below example, we are adding in Training Stress Score.
First change the Title to TSS, and then change the CONTENT to Training Stress. Leave the Channel on TSS
Combined as we want to see both pace and power data. Change the Color to GRAY, the FORMAT to a
BAR and then push APPLY. Your Details tab should look like this when you are done with the above
instructions.

Now your chart should look something like this:

We see below how to change the date range inside the OPTIONS>CUSTOMIZE THIS CHART menu. ON
the GENERAL Tab, you can edit the title, change the size of the chart and also edit the date range.

Another great tip to use with the Periodic charts is to change the 'DAYS PER POINT' on the DETAILS tab,
so that you can have each point representing a week of data or month of data, etc. When you choose 7
'days per point' , then this means that the very best value for that given data series is being plotted(if of
course you are choosing mean maximal). If you have a chart that is looking at AVERAGE WEIGHT over the
week, then you would see the AVERAGE weight for that week as represented in that one dot.

ZOOM  this changes the size of the chart so that it displays near full screen. To return to the normal view,
click on the X next to options in the upperright corner.
PRINT  will print the actual chart
CLONE  create a new chart with the same settings
MOVE  move the chart to a different perspective
Performance Management Charts

The Performance Manager Chart helps you to figure out when you are going to PEAK in your fitness. The
Blue Line is called the CTL(chronic training load) and is your TSS/d over the last 42 Days, which relates
closely to your level of fitness. The Pink line is your ATL(Acute Training Load) and is your TSS/d over the
last 7 days and is related closely to your fatigue. The Yellow line is your TSB(Training Stress Balance) and
tells you when you are rested and fresh or not.
One of the features of the PMC is that you can filter your data by Sport Type. So you if are a triathlete, then
you can look at your PMC for just your Running Data or just your Cycling Data. Read below for some more

instructions on how to segregate your data.
Another exciting feature of the PMC is that you can ADD in your "10 Best" performances to see how they
relate to your fitness and fatigue. Read below for more info on this as well. (see # 5 below)
For more information on how to interpret the Performance Management Chart, please see Power 411
Customizing the Performance Management Chart:
1.
2.
3.

4.
5.

6.

Under "Options" select "Customize Chart".
From the "General" Tab, you should change the Date Range. We recommend that you have
at least 6 months of data on this chart.
You also might want to change the STARTING VALUE for both the CTL CONSTANT and the
ATL CONSTANT. We recommend that you multiply the average amount of hours per day that
you ride by 0.70 and that should give you a starting point. Use this value for both the ATL and
CTL.

You might also want to experiment with the CTL CONSTANT and ATL CONSTANT. By
changing the CTL CONSTANT, you will impact the cumulative impact that your ‘longer term’
workouts will have on your chart. The default value is ‘42’ days, which means that even
workouts done 42 days ago will impact your PMC. By changing the ATL CONSTANT, this will
impact the ‘shorter term’ workouts and their emphasis. If you are someone that needs longer
to recover, it’s possible you should lengthen this time constant to something longer than 7
days.
Under the DETAILS tab, we recommend that you ADD a DATA SERIES

○
○
○
○

7.

8.
9.

Click ADD
Change the TITLE to "20 Minute Power"
Change CONTENT TO "MEAN MAXIMAL"
Leave SHOW BEST to 10 (this will show you ONLY the TOP 10 points for the
data range)
○ Change DURATION to "20 minutes
○ Change color, etc. to your desired choices
○ One key here also is to use the SPORT FILTER if you only want to see your 20
minute MMpace for example and chart that along with your 20 minute MMpower.
Here is where you can split out those data sets.
Under the SPORT tab, you can deselect or select which Sport you want to chart as well.

Now you will have a PMC chart that will show you exactly where your "TOP 10" best 20
minute powers occurred. This is handy as it will help you to identify the TSB that you needed
in order to create those peaks.

10.
11. You might also want to add in your "1 minute" power as a DATA SERIES as well. The longer
you taper before your big race, the greater your short term power will be, so a long period of
(+) TSB could produce some very high wattage values in your shorter durations.
12. If you want to add in some more definition to some of your lines, for example the TSB line, you
can ADD a 2nd TSB DATA SERIES and make it a BAR under the FORMAT choice. Note, in
the example below, the 2nd TSS data series is black and added as a bar. You can make it a
line if you like!

13.

For the Multisport athletes out there, The PMC is a handy tool to help you understand where your Training

Stress is actually coming from and how much of each sport it is comprised. Let's look below at how to
make a PMC for a Triathlete. We'll make a Running PMC first, add your "10 bests" pace data to it and then
we'll make a Combination of them next and finally you'll see a chart with both pace and power data in the
"10 Bests"
To segregate out the running data first, then under the OPTIONS>CUSTOMIZE THIS CHART>SPORT TAB,
uncheck all of the sports and then recheck only the RUNNING box. Hit Apply and Close.

Now, that you have JUST your Running TSS plotted in the chart, you are going to want to add in your "10
bests" for pace. For this example, let's add in the BEST 7 minute mile pace.

Your Chart will now look like this. Feel free to ADD more data series in here.

Now, let's make a combination of the TSS for power and rTSS for running all on the same PMC. To do this,
all you need to do is click on the SPORT Tab and check the BIKE box and hit apply.

Now that we have added the bike data into the PMC, you can also add in the 20 minute (or any time period
you want) power to the chart. Click ADD in the details tab and then make sure under the sport filter you
choose BIKE only for that data series.

The trick here is to make sure the SPORT is correct for each data series that you add into the chart.

Other general options for this Chart include:
COPYyou can copy either the chart picture or the RAW DATA and paste them into an email or another
document.
CUSTOMIZE  click this option to customize the chart (as described above)
ZOOM  this changes the size of the chart so that it displays near full screen. To return to the normal view,
click on the X next to options in the upperright corner.
PRINT  will print the actual chart
CLONE  create a new chart with the same settings
MOVE  move the chart to a different perspective

Athlete Calendar

The Calendar tab is a list of workouts for the current season. You can change the time frame that is shown
by changing the "Dates" dropdown box selection.
ADDING WORKOUTS: There are different options for adding workouts from the Calendar Tab:
1.

Use the Device Agent to download data from a device. Click the Download Device link to open
the Device Agent. Or, go to "File...Training Device Download"

2.

Download data from your TrainingPeaks account. To do this, go to "File...Download from
TrainingPeaks.com"

3.

Manually create a workout. Click on the "Create" link. Or, go to "File...Manual Workout
Entry" This will give you a place to enter in some general information about the workout if you
did not have a power or pace download for your workout.

RIGHTCLICKING: There are many things you can do wtih a rightclick on the calendar. To access the
menu, you just need to rightclick on a workout and you will see the menu pop up with many shortcuts and
options.

USING FILTERS: In the upper calendar menu, you will see there are a variety of ways to filter your data.
The image below is a closeup of the filter options.

FIND: The find feature allows you to quickly search through your workouts for key words. All of the words
that you type in your 'description' and 'postactivity comments' are keywords and can be searched. So for
example, every time you do the "Thunder Ridge Loop", you should type into your 'description' Thunder
ridge.

Or everytime you do 2 x 20minutes at FTP, you should type in 2x20 FTP. This will allow you to

quickly find workouts that you have done in the past.
SPORT AND WORKOUT: If you have assigned a Workout Code (under Journal Tab on the workout) and
also a SPORT type then you can filter by these as well. CLICK HERE to read how to change your Workout
Type and how to assign a Workout Code. An example of using Sport and Workout code is if you want to
look at all your Saturday group rides. If you have been coding these as the same Workout code, you can
filter and show only your Saturday group rides. From there you can pull them into the chalkboard to do
more analysis. Another example is filtering for all your VO2 coded workouts. You can filter these down and
compare them. Using the filter feature is a very powerful tool!
Dates: Adjust your date range here. Check the HIDE BLANK if you would like to HIDE the BLANK days in
your calendar.

Athlete Chalkboard
The Chalkboard area allows the user to see a range of filtered charts. You can filter your data by changing
the Sport Type, or the Workout Code, or just by typing in a "keyword" in the search box. When you first
access the Chalkboard, it will be blank. So, the best thing to do is to first FILTER your data and then 'send'
it to the chalkboard, by clicking the UPDATE CHALKBOARD button.
Again, the easiest way to use the chalkboard is to filter a range of data in your calendar that you would like
to see just that set of charts for.
In the example below, we are filtering the data by a keyword. Each time this particular athlete has done a
fitness test, he has typed the word "test" in either the Description or Post workout activity comments. This
filters through all of the workouts done and selects just those workouts. With this new data subset, now
click on the UPDATE Chalkboard button to send that data to the chalkboard.

Once you have clicked the >UPDATE Chalkboard< button then all that data is sent to the BLANK
chalkboard, So now you have to make some charts!

You will want to change the date range of the chart in order to make sure you emcompass the date range
that your data covers. If you have selected a PERIODIC chart then you will need to ADD in data to the chart
in order for it to chart properly.

Now you should have some charts that build and show you JUST the data you want to see.

Workout Data
To open a single workout for analysis, doubleclick the workout from your athlete's calendar. Click on one of
the four tabs to access that specific part of the workout data.
JOURNAL
GRAPH
QUADRANT ANALYSIS
SCATTER GRAPH
RANGES

Journal
The Journal view provides charts and summary information for the workout. You can click on the Workout
Settings area to make updates to the data, add a Workout Goal, change the Sport Type, or add
postworkout Notes.

SPORT TYPE
WORKOUT CODES
POWER PROFILE
ADDITIONAL FEATURES
JOURNAL CHART FEATURES
SPORT TYPE: To change the Sport Type of a workout, click the dropdown box next to "Sport Type" and
select what type of workout you want to use.

Back to Top
WORKOUT CODE: You can assign workout codes for your training. This allows you to filter your data for
specific workouts codes. For example, if you have a hill climb you do often, you can create a workout code
for that, and then use the filter option on the calendar tab to see only the workouts that were assigned that
hill climb workout code. From there, you can add the workouts to the chalkboard for further analysis.
We suggest that you create one coding system and stick to it. Codes are CaSeSenSitive, so if you use
"Hills" and "hills", you will create two different codes. We recommend you use ALL CAPS for your naming
scheme.

POWER PROFILE: All new with the latest data from Dr. Andrew R. Coggan and Hunter Allen, incorporating
the best files in the world and allowing you to compare yourself against the best. Now, with the ability to
see your 20 minute power as well. Click on the Power Proflie icon to access this.

Back to Top
ADDITIONAL FEATURES: Click the "Options" button in the upperright corner to access additional features
of the journal view:

SAVE THIS PAGE SETUP AS DEFAULT: This means that once you have customized all the charts on
your Journal page, you can save this configuration for all future workouts downloaded or brought into WKO.
It will NOT go back in the past and apply this new configuration to older workouts, but will apply it to new
ones.
EXPORT ALL CHARTS' Settings: If you would like to share this page setup with another one of your
computers or with a friend, then you can save this page setup in a .cht file and then email that file to your
friend.
IMPORT AND REPLACE ALL CHARTS' SETTINGS: On the other side of this is when you receive the .cht
file and now you want to click IMPORT AND REPLACE and then point to that .cht file and you'll then be
able to have the same configuration of your friend or your primary computer.

JOURNAL CHART FEATURES: There are also features that come with each journal chart. To access the
list of features, click the "Options" link at the righttop of each chart. These features can include:
COPYyou can copy either the chart picture or the RAW DATA and paste them into an email or another
document.
CUSTOMIZE  click this option to customize the distribution chart
ZOOM  this changes the size of the chart so that it displays near full screen. To return to the normal view,
click on the X next to options in the upperright corner. NOTE: if you ZOOM on the chart and then make
changes to that chart, those changes won't be saved, when you revert back to the normal size. Please
make your permanent changes on the normal size chart before you zoom.
PRINT  will print the actual chart
CLONE  create a new chart with the same settings

REMOVE  will delete the chart from your journal view
MOVE  move the chart to a different perspective
ADD CHART TO THIS PAGE  gives you the ability to add a customized chart to those charts already
included on your journal view. Use this feature when you want a new chart into the Journal page.

Graph Page
GRAPH PAGE: This is where you can view a graphical representation of your workout. Its the workhorse of
WKO+ and a place where you will be able to drill down into your workout and examine every detail.
VIEW HEART RATE, POWER, PACE, ETC.
RANGES

SCALE YOUR DATA
FAST FIND
FIX HEART RATES
FIX ERRONEOUS DATA POINTS
HIDE/UNHIDE THE NAVIGATION BOX
CUT, COPY AND PASTE
CREATE A GRIDLINE
STACKED VIEW
HORIZONTAL VIEW
ZOOM YOUR DATA
SMOOTH YOUR DATA
VIEW YOUR RAW DATA
VIEW DISTANCE AND/OR TIME
View Heart Rate, Power, Pace, etc.
There are two options to view the different available channels of data:
1.

Click on "View" and then check or uncheck the data series you want to view in your graph.

2.
3.

You can also click on the down arrow beside the "D" icon on the toolbar at the top of the
graph, click on that and select any of the bolded Data channels available.

4.

Scale Your Data
You can either show your data based on time or distance. To do this, use the T / D buttons above the
graph. Or, click on the "Scaling" link in the top menu.

Fast Find
This feature allows you to automatically find specific times when you went over a certain amount of watts
and for ho long. Want to know how many "matches" you burned in that race last weekend?
Well, for you a "match" may be every time you go over 400 watts for 1 minute. With this knowledge you
can automatically "find" these areas. Here's how:
1.
2.
3.
4.

5.
6.

With your Graph open, go to "Edit...Find". Here you can find specific areas of interest
automatically.
You can select the area you want to search at the top of the window  Range of Interest
Under leading edge, select the amount of watts you want to use as your "floor". So if you are
looking for all your efforts Over 400 watts, then place 400 watts here.
Under Trailing Edge, select the amount of watts you want to determine that "deselects" the
"Find". So, if you want to see all efforts that you did that were over 400 watts, ad you want to
see when it dropped below 200 watts afterwards, this is where you would place 200 watts.
Select the time duration you want to determine for your efforts.
Click "Find"

7.
One tip if you are having a hard time finding the 'matches' you want, then first lengthen the Trailing edge
consecutive samples. That will help to continue to 'select' the match even if you reduced your wattage for
more than a few seconds.
Fix Heart Rates

To fix heart rates, click "Edit...Corrections...Fix Heart Rates". This will fix heart rate dropouts very well if the
dropout lasted less than 5 samples. After that, you may want to choose to edit your HR manually through
the Raw Data option.

Fix Erroneous Data Points
You can manually fix erroneous data points by access the raw data. To do this, click on the "123" icon to
the left of the graph icons: Then just type in the grid in the place that you want to have it corrected. For
example if at 2:52:32 into the ride, your wattage spikes to 2300watts and you know you didn't do that(!),
then you might want to scroll down to that time, and then edit the wattage number to a more reasonable
number.

Hide/Unhide the Navigation Bar
You can hide the Navigation Bar and make it only appear minimally along the leftside. To do this, click the
Icon to the right of the "Navigation Explorer" header:

Once you have hidden the navigation area, it will look like the following. Click on a header to expand that
area:

Finally, if you want to keep the area unhidden, expand one of the areas as described above, then click on
the icon that you originally used to hide the entire area:

Back to Top
Cut, Copy and Paste
You can cut out a section of the graph if it is not good data or you don't want to view it. Click and drag your
pointer to the right to highlight the area you want to cut. Then go to "Edit...Cut". Your data will be cut out of
the graph. You can also use this feature to cut out a specific section of data and then PASTE it into a
NEW WORKOUT(under the GRAPH page), so that you can view all of the charts(in the JOURNAL page) for
just that subsection of the data.
You can also use Copy in the same way, if for some reason you want to copy the data out of the graph,
open a new workout, and paste it into the new workout. This is a great way to handle the problem of two
rides downloading, because you weren't able to download after the first one. Then you can just Cut the first
ride out and Copy it to a new workout.

Create a Gridline
1.
2.

Move your pointer to the FAR left or RIGHT sides of the graph.
Now your pointer will be in the "Legend" part of the graph, where watts, HR, speed, etc are
detailed. For this example we'll create a power gridline.

3.
4.
5.

6.
7.
8.

Left click and hold down the left button while having your pointer in the yellow power legend
DRAG the pointer onto the graph and place the gridline on the desired value.
You can see the desired metric now displayed on the bottom left side of the screen:

To create a gridline for any other legends, repeat the steps above.
You can also create gridlines by doubleclicking on the legend part and then clicking on the
white box and type in the # that you want. MAKE SURE the "eyeball" is turned on first, or it
will not create a gridline on the graph.

9.

Stacked View
This is the default view in WKO+. Click the Stacked view icon located ont he toolbar. It shows your data at
one data point per pixel on your screen. This shows your true and actual data the way it was recorded by
your device. You view your data in its true form.

Horizontal View
In this view, your data is smashed. All of it is pushed together to fit in one screen. However, there are really
cool features associated with both of these graph configurations. ZOOM in and RIGHT click. Drag the
pointer to the right to highlight the area of interest. Let go of the right button and a small window will appear.
Select Zoom and this will Zoom in on that area and 'fit it to size' in your screen. You can continue to do this
until you get to the actual threefour data points that completely fill your screen.

Zoom Your Data
The Zoom Function allow you to enlarge or shrink a specific section of a graph. There are a few different
options for zooming:
●
●

●
●

Select "Zoom" then click IN (F5) or OUT (F6) to increase or decrease the zoom.
You can use the shortcut keys Ctrl+> and Ctrl+< OR you can use F5 to zoom out, F6 to
zoom in.

Zoom a range by rightclicking on the range name and then select "zoom range" from the
popup box.

●
●

Zoom a specific section by highlighting the section and then select "Zoom...Fit Selection"

●
●

Anytime you want to exit a zoomedview, click on the graph icons at the top of the screen

●

Smooth Your Data
There are three options to smooth your data:
1.
2.
3.

Click on "Smoothing" and then check "more or less" based on how you want to view the data.
Click on the up or down arrows that are to the right of the 0:00 box located on the toolbar.
This is the time period that you are smoothing.
Use your keyboard shortcuts: ctrl+] for more or ctrl+[ for less. Or use F3 to smooth more or
F2 to reduce smoothing.

4.

View Your Raw Data
To view the raw data for a workout, click on the 123 button at the top of the page in the toolbar. This will
display your raw data where you can change any erroneous data. SEE also FIX ERROREOUS DATA
POINTS

View Distance and/or Time
You can click on the "T" or "D" icons on the tool bar at the top of the screen.

How to use Quadrant Analysis
There is a lot of valuable information on this page. To make it easier to read, we have it broken down into
three parts, but it is recommended that you read through the entire thing to get an understanding of the
Quadrant Analysis feature.
WHAT IS QUADRANT ANALYSIS?
HOW TO USE QA?
FUNCTION OF THE 'EYES' INSIDE QA AND CLICKING ON THE TEXT IN RANGES BAR
What is Quadrant Analysis?
Quadrant Analysis is a way to measure the neuromuscular power demands of cycling. Taken from the
book, "Training and Racing with a Power Meter by Hunter Allen and Dr. Andrew R. Coggan, "Tools such as
Normalized Power, Intensity Factor, and Training Stress Score explicitly recognize the seemingly
stochastic nature of cycling power output and help coaches and athletes better understand the actual
physiological demands of a given race or workout. Even so, to completely understand the physiological
consequences of large variations in power, one must also understand how they impact neuromuscular
function—that is, the actual forces and velocities that the leg muscles must generate to produce a given
power output. Such effects are recognized by the algorithm used to calculate Normalized Power, but only to
the extent that they influence metabolism (e.g., via altering fibertype recruitment patterns). Although
strength (or maximal force) per se is rarely a limiting factor in cycling, neuromuscular factors nonetheless
can still sometimes play an important role in determining performance. Thus, we realized that it would be
useful to be able to analyze powermeter data that captures this important information in a form that could
readily be grasped even by nonexperts.
Neuromuscular What? “Neuromuscular function” may sound complicated, but it simply means how fast you
can contract a muscle, how strongly you can contract it, and how long you can contract it before relaxing it
again. When someone learns a new movement pattern—it could be anything from learning how to type on
the keyboard to pedaling a bicycle—those movement patterns are governed by that individual’s ability to
transfer the information from his or her brain to the muscles that are involved. We all take this for granted,
and when it comes to cycling we just pedal, but in reality each of us is different in our ability to make these
contractions occur. With your power meter, you can begin to understand your neuromuscular ability, and
you can determine whether you are training correctly for cycling success and then begin to improve your
neuromuscular power.
What are these units on the Y and X axis?
On the Y AXIS: The velocity of muscle contraction (as indicated by cadence) is only one of two
determinants of power, with the other, of course, being force. Unfortunately, at present no power meter
directly measures the force applied to the pedal. However, it is possible to derive the average (i.e., over 360

degrees) effective (i.e., tangential to the crank) pedal force (both legs combined) from power and cadence
data. The equation looks like this:AEPF = (P*60)/(C*2*Pi*CL)
In this formula, AEPF stands for “average effective pedal force” (in newtons, or N); P is power, in watts; C is
for cadence (in revolutions per minute); CL is for “crank length” (in meters); and the constants 60, 2, and pi
serve to convert cadence to angular velocity (in radians/seconds). Additional insight into the neuromuscular
demands of a race or training session can then be obtained by preparing a frequency distribution histogram
for AEPF that is similar the one for cadence, as shown in Figure 7.3. (Note that, as with all such plots,
graphs like this one do not take into consideration how long AEPF was continuously within a given “bin,” or
range. This is not an issue, however, because unlike, for example, heart rate, neuromuscular responses and
demands are essentially instantaneous. Indeed, it is the generation of specific velocities and forces via
muscle contraction that essentially drives all other physiological responses.)
Although simply examining the frequency distributions of AEPF and cadence provides insight, it does not
reveal the relationship between these two variables. This relationship can only be quantified by plotting force
versus velocity.
On the X AXIS: Circumferential pedal velocity—that is, how fast the pedal moves around the circle it makes
while pedaling—is derived from cadence as follows:CPV = C*CL*2*Pi/60
Here, CPV stands for circumferential pedal velocity (in meters/second); C is for cadence (in revolutions per
minute); CL represents crank length (in meters); and the constants 2, pi, and 60 serve to convert the data to
the proper units. Although technically, muscleshortening velocity, or at least joint angular velocity, should
be used instead of CPV, CPV has proven to be an excellent predictor of both of these. Indeed, since crank
length is generally constant, especially for a given individual, one could just as well use cadence instead of
CPV. However, we have used the latter here to be consistent with scientific convention and to emphasize
the relationship of cyclingspecific plots to the more general forcevelocity curve of muscle. A scatterplot of
force and velocity, such as that shown in Figure 7.4, therefore presents information that cannot be obtained
from just frequency distribution plots of AEPF and CPV.However, it can be difficult to detect subtle and
sometimes even notsosubtle differences between roughly similar rides based on such “shotgun blast”
patterns, especially if the scaling of the X and Y axes is allowed to vary. Furthermore, without additional
information, such forcevelocity scatterplots are entirely relative in nature because there are no fixed anchor
points or values that can be used as a frame of reference. It is the latter issue that Quadrant Analysis was
specifically developed to address.

How to use QA?
Using QA is as simple as clicking on the the Quadrant Analysis Tab on your workout View. Understanding
what it means is a different thing though!
Before we delve into the details of understanding them, we should point out the features inside the QA tab,
so you can make sure you are interpreting them correctly.

Threshold: This should be the threshold that you set inside your Power Training zones on your Athlete
Home page. If this is not correct, you can change it here, by typing in a new Threshold value, or by Creating
a new power zoneon your Athlete home page
Lo Threshold: this should be set at about 2030 watts under your Threshold value, just to give you some
perspective on the graph.
Hi Threshold: this should be set at about 2030 watts above your Threshold value, again, to help you with
some perspective on the graph.
TCadence: This is the Threshold cadence. It's your normal selfselected cadence in which you would
average when you do a threshold interval.
Crank Length: The Crank length of your cranks on your bike.
Centering the Axes This is a somewhat hidden, but very easy and useful feature. You can change the
center of the axes, by just double clicking anywhere in the view. Doubleclick in the upper right and it pulls
the axes to the upper right. Doubleclick to the lower left and it pulls the axes to the lower left. Simple and
can really help you read the chart more clearly.

Back to Top
Functions of the 'Eyes' inside QA and clicking on the TEXT in the Ranges Bar.
The functions of the 'Eyes' inside QA and clicking on the text (entire ride, peak 5 minutes, etc) have some
specific functions, similar to in the graph page but with a few little differences.
When you click on the text for example 'Entire Workout', then the points will all be yellow. This is the default
and master color in the QA tab. Note the very small Yellow Triangle in the Data set. This is the Average of

all the Data. Note also the percentages in each of the corners. The First number is the percentage of data
in that quadrant in relationship with the other quadrants. The percentage number in parenthesese is the
percentage of data that is inside a range on the right. See a little bit farther down for an example.

Now, when you click on an 'Eye', this changes the color to red and shows you exactly where that selection
of data is inside the QA. This is very useful as it allows to you see if you completed the interval, section of
ride correctly as compared to your goal or workout.

Now, finally, if you click on the text word beside the 'Eyes' column, then the section of the workout that
does not include the 'Eyes', turns to blue. Note that a 2nd Triangle appears now. This is the average of the
data for that range that you clicked on. In the example below, there now a yellow triangle inside QIII which
is the average of the data that is highlighted (in blue) on the Ranges window. The Average of all the data is
still there, but now it is a red triangle.

Now, review the screenshot above more closely and you'll see that the percentages in the corners have
changed. In the QIII corner, we have 33.3% which represents how much time was spent in QIII for the entire
workout and then in parentheses, we have 33.1% which represents how much that range is as a percentage
of all the data in QIII.
Let's look at a Comparison QA and see what the quadrants mean:
Every ride you do, every workout will have an aerobic/anaerobic (cardiovascular) component to them and a
neuromuscular(the muscles!) component. As we said above, how you create the watts can be an important
factor in your training. Each quadrant represents a different combination of force(how hard you push on the
pedals) and pedaling velocity(how fast you push on the pedals).
QI: High Force and High Cadence An example of this would be sprinting.
QII: High Force and Low Cadence An example would be steep hill repeats, big gear intervals and a lot of
Mt. Biking resides in QII as well.
QIII: Low Force and Low Cadence An example would be a recovery ride or just an easy ride around town.
QIV: Low Force and High Cadence An example would be a Criterium or fast pedaling drills.
The below screenshot compares a Criterium, Road Race, Time Trial and a CycloCross race together. This
was done by creating a Multifile/Range Analysis and then clicking on the QA tab at the top to have a
MultiFile Quadrant Analysis(MFQA)

In the next example below, we see just the criterium race. Most criteriums are characterized by high
speeds, fast turns and plenty of sprinting. In a criterium, you have to use a gear that allows you to quickly
change speeds to keep up with the ever surging peloton. When you examine the QA below, you see that
most of the time is spent in QIV, which represents Fast pedaling at a low force and this makes perfect
sense for a criterium. The next largest percentage of time was spent in QI, which means this rider also had
to do some sprints in order to stay in the race.

When examining a Mt. Bike race file and comparing it to a road file, you can easily discern the differences
betwen the neuromuscular demands fo the two workouts. This is where the QA really shines in
demonstrating to you that the demands of a race can be very different from the demands of your training
ride, even though you are doing your best to simulate a race. In the case below, we see that it's very
difficult to create the same neuromuscular demands on a road bike as those that are created in a Mt. Bike
race.

Now, lets examine a Microburst workout on a Trainer and compare that to a Criterium. A Criterium as
represented in the QA above, places a large load in the QI area.

Can you simulate a criterium race by

doing a workout on the trainer? More specifically, will a Microburst workout(15 seconds ON at 150% of
FTP and 15 seconds OFF at 50% of FTP) be a rough equivalent of a Criterium race?.

From these examples, we hope you have learned more about how to use this tool. Looking at both the QA
from an individual file to help you learn more about those files and the neuromuscular demands of them,
along with comparing multiple workouts together in a MFQA. These will help to better align your training

with your racing demands, and along with your cardiovascular training, you will be assured that your
neuromuscular power demands are being met as well.

Scatter Graph
Scatter Graph is also a new graph inside Version 3.0. Behaving very similarly as the Quadrant Analysis
graph, the key difference is that you are able to change the 'channels'(power, HR, Cadence, etc) on the X
and Y axes. With the Scatter graph, you can better understand the relationship between your data channels
for each ride. Want to know if your cadence changes as you produce more power? Then plot Cadence on
the Yaxis and Power on the Xaxis. Want to know how your speed changes in relationship to your
cadence or gearing? Then plot Cadence on the YAxis and Speed on the Xaxis. Want to know what at
what Heart Rate you produce power at the most? Plot Heart Rate on the YAxis and Power on the Xaxis.
Lets look at some screenshots below so you can get a better understanding of what these 'shotgun blasts'
mean and how they can make you a faster cyclist!
The below screenshot shows a plot of the HR to power relationship in a CycloCross race. Note how there
are 3 distinct areas that the HR was in during the race(Warmup/cooldown, Recovery HR during race, and
then HR while racing hard) and how those compare against the power produced. The range of power goes
from Zero watts all the way to 800 watts, while the HR remains in a narrow range of 160173.

This next screenshot illustrates the relationship between speed and cadence. This is also the same CX race
as above and with Cadence on the Yaxis and Speed on the Xaxis, it shows us how linear the relationship

between the two can be. At a certain point though the athlete is no longer able to(or chooses not to) pedal
any faster for a similar increase in speed. He changes to a harder gear and puts out more force and
reduces his cadence in order to create that top end speed. This could indicate a couple of different things
to you. 1) That this athlete needs to be able to pedal faster than he currently can/wants to, and/or 2) In this
CX race the ability to push harder(produce more force) is also important therefore muscular strength must be
trained.

In our next example, we have a scatter graph of Power on the YAxis and Heart Rate on the Xaxis. This
particular workout was a Test for the athlete and taken out of the "Training and Racing with a Power meter"
book. In this case, the "eyes" on the ranges have been checked and this makes the ranges RED and then
with a TEXT word(in this case 15 second) highlighted, the rest of the ride is colored BLUE. This plot is a
great example showing the power for each test time period and the corresponding heart rate. It really goes
to show how the higher power numbers are not really related to a specific heart rate zone.

This next screenshot is pretty interesting to see. This is the same testing protocol as above, but now with
Power on the Yaxis and Speed on the XAxis. What this exponential curve shows is the forcevelocity
curve of the indoor trainer that this athlete was using during the test. While the athlete was able to produce
the maximum watts in the test that he could produce, his speed was limited by the force/velocity
characteristics itself.

As you can tell, the scatter graph has a lot of applications in analyzing your power file. Understanding the
relationship between your power and also your other data can give you an advantage in deciding the type of
training that is needed for your event or what the specific demands are for your event.

Ranges
The data displayed on the Graph page can be divided into ranges. By using ranges, you can review distinct
events within the data.
UNDOCK YOUR RANGES BOX
HIDE YOUR RANGES BOX
HIGHLIGHT AN AREA ON THE GRAPH OR MAKE A SELECTION
CREATE A NEW RANGE
AUTORANGES
SHOW RANGE
NAMING AND RENAMING A RANGE
LINKING RANGES TOGETHER
SCROLLING THROUGH RANGES
DELETE A RANGE
CHANGE THE START OR ENDPOINT OF A RANGE
ZOOM A RANGE
AUTO SPLIT RANGE
DISCOVER A RANGE
FIX ELEVATION PROFILE USING GPS
OVERRIDE ALTITUDE MANUALLY
GOOGLE EARTH / GARMIN

Undock Your Ranges Box
You can undock your ranges box and let it "float" in the graph window by right clicking on any gray space
on the ranges and dragging it onto the graph area. You can also doubleclick on the gray area to undock it.
You can change the size of the ranges box when it is undocked. To get it back into place, just doubleclick
on the gray area, and it will be docked again.

Hide the Ranges Box
You can hide the ranges box by unchecking "View....Ranges Bar". To return the navigation box to the left
side of the graph, check the "View...Ranges Bar" option.

Highlight an Area on the Graph or Make a Selection
Place your cursor on the graph, leftclick your mouse, and drag the cursor across the graph to where you
want the range to end. Release leftclick. In the Ranges Box you will see the text "Selection" highlighted.
Your data for that selection will be in the data box below. Now you've created a temporary selection!

Create a New Range:
1.
2.
3.
4.
5.

6.

7.

Place your mouse cursor on the area oft he graph you want to highlight
Left click and hold down the left button
Drag to the right or left to "highlight" the area
Let go of the left button.
Notice in the ranges window that there is now a "selection" highlighted. You can see the
details of this "selection" in the bottom half of the ranges widow. Rightclick on an area of
data to create a range. Or, use Control+R to create a "New Range" OR go to "Edit...Create
Range". A new range appears on the list and you can label that range however you wish. For
example: "10minute LT interval".
To save the range, be sure to name it!

Auto Ranges
You can auto select Peak ranges based on the following categories/icons in the toolbar:
1.
2.
3.
4.
5.
6.

Power
Cadence
Heart Rate
Speed
Pace

7.

Show Range
Click the range name to show the range data. Rightclick on the gray boxes next to a range to highlight that
specific range on the graph, as well as hide other ranges, or zoom on that particular range to study it. You
can also leftclick on the box the arrow points to, that will give an "eye" icon and show the range on the
graph.

Naming and Renaming Range
Once your range is created, you can name it by typing in the range. You can also doubleclick the
selection in the ranges window to rename it. This is how you save a range.

Linking Ranges Together
Once you have created a bunch of ranges, you can "Link" them together. By clicking on the button just to
the left of the "named range", a small "link" will appear. Linking ranges comes in handy if you are going to
use the Multi File Analysis feature! For example, if you did a ride with multiple tempo efforts, you can link
those ranges together and view them in the Multi File Analysis feature.
1.
2.

3.
4.

Click on the ranges you want to link together.
This prevents you from having to retype the name multiple times and it also will give you the
rest period between each liniked interval in your summary Section on your Journal page for the
workout.
Click the eyeball to highlight the range.
Click on the Named range to see the data for that range.

Linking ranges together can be used multifile analysis, for more information, CLICK HERE.

Scrolling Through Ranges
You can quickly scroll through ranges by clicking on one range name, and then using the arrows,
pgup/pgdn, home, or end to move through the selection.

Delete a Range
Press the DEL key to delete the currently selected range or rightclick a range and select "Delete Range"
from the menu.

Change the Start or Endpoint of a Range
Rightclick a range and select "Edit Range" from the menu. While holding the shift key, move the blinking
cursor forward or backward with the arrow keys. Press Enter when finished.

Zoom a Range
Rightclick on the text of the range you want to highlight in the ranges box. Select "Zoom Range" from the
menu. This will ZOOM that area and fit it to size in your screen. You can continue to do this until you get
to the actual threefour data points that completely fill your screen.

Auto Split a Range
This feature is especially helpful to runers who would like to find out the pace of each mile run. Here you
can select and Auto Split a range by first rightclicking and then dragging to highlight a specific range,
release the click and select "Auto Split Range". The file must contain GPS data to use the Auto Split tool.

Discover a Range
To automatically discover a range in the graph window, click the “eye” first, then click the text of that range
to highlight it . This will automatically move the window to make that range inside your viewing window.
For example, you might want see in a 5hour ride, where your peak 5 minutes occurred. Click the “eye” on,
across from the –Peak 5 min text. Then click the text itself and the program will autoscroll to that effort.

Fix Elevation Profile Using GPS

You can fix your elevation profile for any GPS. First create a range, and then rightclick on that range from
the Ranges Bar. Next, select "Fix Elevation Profile Using GPS". You will need to have your
TrainingPeaks.com username and password entered in your account settings in order to use the Ground
Control option. This is the recommended Option.
For runners, fixing elevation will fix your running elevation calculation, which is critical for Running TSS.

Override Altitude Manually
In addition to the option of fixing a workout's elevation profile by using GPS, you can also fix altitude
manually. To do this, Right Click on a range from the Ranges Bar and select "Override Altitude manually"
from the menu. You will get a popup box that allows you to change the range's beginning elevation and
average grade. You can do this for multiple ranges on your workout, or for the entire workout.

Google Earth / Garmin
In order to export your data and export it to Google Earth, rightclick on any range in the range window and
select "Export to Google Earth". You must have Google Earth installed on your computer, and be working
with a GPS file. By rightclicking on a range, you can export the entire workout or just one specific range!

Troubleshooting
TrainingPeaks WKO+ is compatible with many devices. New devices come onto the market quickly and we
update our software as fast as possible. For the latest list of compatible devices, CLICK HERE. For
troubleshooting help on a device, click on your specific device from the list of compatible devices.
UPLOADING TO TRAININGPEAKS.COM
TIPS AND TRICKS
ERROR MESSAGES
Uploading to TrainingPeaks.com
Below are a few tips for uploading to TrainingPeaks.com:
●
●
●
●
●

From WKO+ athlete's Settings area, make sure you select "True" in the box "Enable
TrainingPeaks.com upload".
Doublecheck all the spelling on your username and password
If you do not have a TrainingPeaks.com account, you can sign up for one at:
www.trainingpeaks.com

Tips and Tricks
●

●

●

Can't find a file?
○ Did you delete that file from C://program files/CyclingPeaks WKO+/data ???
○ Do you have a virus? Scanned for one lately?
○ Did you install on a 2nd machine this weekend?
○ Changed your 'name' around on the Athlete Home page?
○ TIP: Look in C://program files/CyclingPeaks WKO+/data/ and confirm that your
data is in there. There should be a file with your name on it, and all the .wko files
included.
Have a bad data/wko file and you want to get rid of it?
○ TIP: Using Windows Explorer, goto C://program files/CyclingPeaks/data/your
name. Then find the most recent files that could have caused the error. CUT them
out of that directory. PLACE them somewhere else (suggestion: make a folder on
your desktop and place them there). Then try to reopen. If that does not work,
then keep subtracting on file at a time until you are POSITIVE you have gotten to a
date that you know WKO+ was working. Then ReOpen WKO+.
○
Combining multiple workouts:
○ First, open up both workouts and select the second workout. From the Graph tab,
highlight the range you want to copy on the graph. From here, CUT/COPY your
data out of this workout (use the EDIT link on the toolbar). Now go to the first

workout (you will see them both listed in teh navigation panel on the leftside of
your screen) and PASTE the range into this 1st Workout's graph.

Error Messages
Below is a list of common error messages that you may see:
●

●

●

●

Message: "Unexpected file format"
○ Solution: You most like tried to import a workout that is not currently compatible
with WKO+, please double check this and be sure that you have the latest version
of your the software.
Message: "Timeout waiting for device"
○ Solution: Check to be sure your device is plugged in properly and that you have
installed the proper device
Message: "A valid CD Key was not provided or it has already been used, please check your
CD Key"
○ Solution: Your registry file has been corrupted
Message: "Cannot Quit WKO+, Unexpected File Format"
○ Solution: To force quite the application, rightclick on the task bar and choose
Task Manager. Go to the processes tab, locate PeaksWKO.exe, right click and
choose end process. Additionally, you may want to go into each athlete's folder
and delete the Calendar.dat files, once WKO+ starts again, it will recreate these
files.

WKO+ v3.0 System Requirements
WKO+ v3.0 is for PC use only, it is a nonweb based, and installs directly to your computer. Requirements
are:
●
●
●
●
●

PC windows based computer
Operating system: Windows XP(32bit only), Vista(32bit or 64bit), Windows 7(32bit or 64bit)
○ WKO+ is not natively Mac OS compatible at this time.
Available hard disk space: 11MB for the program, plus a very rough estimate of 10MB per
athlete per year.
Super VGA or better (800 × 600 min) video adapter and compatible display.
Connection to the internet is required to download and register WKO+. Once registered,
internet is no longer required.

Users looking to run WKO+ v3.0 on a Mac should be aware of the following:
●
●

WKO+ is not natively Mac OS compatible at this time.
We can not guarantee support for WKO+ when run on a computer that differs from the above

●

●

documented PC system requirements.
If you choose to run WKO+ on a Mac, utilizing a third party program that allows Windows to
run on a Mac, we will do our best to support your use of WKO+, but please note that the
scope of support we can provide is limited when the program is not installed to a PC. That
said, we have seen successful results with using WKO+ on Windows run on Parallels,
Bootcamp, and VMfusion.
The following caveats are known with running WKO+ on Windows on a Mac:
○ If using Snow Leopard (Mac OSX 10.6), we have found that WKO+ will only
work if you have the emulation software set to NOT share files with the Mac
OS. Further troubleshooting with file path related issues on Snow Leopard is
beyond the scope of support TrainingPeaks can provide.
○ Using WKO+ on Codeweavers Crossover Mac, or any other emulation
software that does not run WKO+ within a full license of Windows, is NOT
SUPPORTED. However, other users have found ways to get WKO+ running
in such an environment. Here is a good blog that discusses one method
(please note that we are unable to provide any troubleshooting or support with
this setup, including any issues that may arise with activating your license in
a non Windows based environment):

